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Chapter 1 

Application Information 

1.1 Description 
 
The SP4 Telephone Zone Controller (SP4-TZC) controls the zone paging capability of the SAFEPATH®4 
Multi-Function Facility Communications System. It is used in conjunction with the SP40 and the SP4-APS 
(SP4 Addressable Paging Splitter). Audio Boosters SPB-80/4, SPB-160, and SPB-320 can be used in 
conjunction with the SP40. Each audio booster can use additional SP4-APS splitters, increasing the number of 
possible paging zones. 
 
The SP4-APS splitter in conjunction with the SP4-TZC allows the End User to make audio zone specific 
telephone pages and/or have audio zone specific Background Music (BGM) on a Wheelock SAFEPATH®4  
Multi-Function Facility Communications System. This can occur as long as the system is not broadcasting a 
pre-recorded message or when the live microphone is in use. The selective paging and BGM functions are 
controlled by the SP4-TZC over a RS-485 based digital control network.  It also provides a means for 
expanding one supervised audio output zone to 4 CLASS “B” or 2 CLASS “A” supervised zones. The 
maximum number of CLASS “B” zones in a system is 68. The maximum number of CLASS “A” zones in a 
system is 34. 
 
The SP4-TZC can be used with or without the SP4 Telzone Programmer 2 software. The features available 
without using the software include the use of Individual Zones and Fixed Zone Groups for Zone Paging, and 
Background Music on all zones. When using the SP4 Telzone Programmer 2 software additional features 
include Logical Zone Group paging, disabling of Zone Paging (All-Call Paging), user programmable Zone 
Setup options, and customization of Individual Zones for Background Music. 
 
An Individual Zone is one of the individual outputs from an SP4-APS splitter. The SP4-APS splitter can 
produce either 2 CLASS “A” or 4 CLASS “B” zones.  
 
A Fixed Zone Group consists of 2 CLASS “A” or 4 CLASS “B” zones on each SP4-APS splitter. For example, 
if the first SP4-APS splitter is used to cover the zones in the warehouse area the Fixed Zone Group for that area 
can be paged by keying the two digit Zone Code “71” on the paging phone. The Zone Codes for Fixed Zone 
Groups are 71 through 87 with each Zone Code matching the order of the splitters.  
 
When used with the SP4 Telzone Programmer 2 software, the SP4-TZC in conjunction with the SP4-APS 
splitter is capable of programming up to 9 Logical Zone Groups for audio paging. A Logical Zone Group 
consists of 1 to 5 Individual Zones and/or Fixed Zone Groups. It can also program any Individual Zone for 
Background Music. The two digit Zone Code for the Logical Zone Groups are “91” through “99”.  
 
Paging an Individual Zone, a Fixed Zone Group, or a Logical Zone Group is accomplished using a touch-tone 
phone connected to a page port or a touch-tone stand-alone phone. The paging telephone is connected to the 
SP4-TZC allowing it to key Zone Codes each consisting of two-digit DTMF tones. See Table 1 for the dialing 
scheme. Any Individual Zone or Fixed Zone Group that is not known by the system will result in a no page 
condition and the SP4-TZC will start the paging process over. 
 
The SP4 Telzone Programmer 2 software is the second major release of the software, that is designed to operate 
with an SP4-TZC having firmware version 2.xx. It is NOT backwards compatible with an SP4-TZC having 
firmware version 1.xx. For SP4-TZC's having firmware version 1.xx, version 1.x.x.x of the SP4 Telzone 
Programmer software must be used to ensure proper operation. 
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Table 1 
Dialing Scheme 

Dialing Scheme 
Zone Code Zones 

00 All Call 
01 - 68 Individual Zones 
71 - 87 Fixed Zone Groups 
91 - 99 Logical Zone Groups 

Note: Zone Code is the splitter zone DTMF tone. 
 
All splitters must use the same CLASS of wiring (CLASS “A” or “B”) for the audio output zones.  See the SP4-
APS Installation Instructions (P84577) for proper wiring.  
 
Individual Zone and Fixed Zone Group Zone Codes are controlled by the placement of the splitters in the 
RS485 digital communication circuit. The first splitter connected to the RS485 digital control port on the SP4-
TZC will be assigned the first Zone Codes (Individual Zone Codes of “01” and “02” for CLASS “A”, 
Individual Zone Codes of “01” through “04” for CLASS “B”, and a Fixed Zone Group Code of “71”). Using 
the previous example where the first splitter covers the warehouse area, let’s add a second splitter covering the 
front office area. If the paging zones are set for CLASS “A” then the warehouse will have Individual Zone 
Codes of “01” and “02”. The front office area Individual Zone Codes will be “03” and “04”.  The Fixed Zone 
Group Code for the warehouse will be “71”, and the front office Fixed Zone Group Code will be “72” 
 

INDIVIDUAL 
ZONE CODES = 
01,02

FIXED ZONE 
CODE = 71

INDIVIDUAL 
ZONE CODES = 
03,04

FIXED ZONE 
CODE = 72

INDIVIDUAL 
ZONE CODES = 
05,06

FIXED ZONE 
CODE = 73

INDIVIDUAL 
ZONE CODES = 
07,08

FIXED ZONE 
CODE = 74

INDIVIDUAL 
ZONE CODES = 
09,10

FIXED ZONE 
CODE = 75

SP4-TZC

SP4-APS SP4-APS SP4-APS SP4-APS SP4-APS

SP40 SPB-160 SPB-160

#1 #2 #3 #4 #5

RS485

RS485 RS485 RS485 RS485 TO ADDITIONAL 
SP4-APS SPLITTERS

CONNECT THE SP4-TZC RS485 CONNECTION 
TO THE SP40 SP4-APS FIRST.  

 
Figure 1 

RS485 Communications Path from SP4-TZC to CLASS  “A” SP4-APS Splitters 
 

Figure 1 shows the path of the RS485 digital control loop and the sequence of the splitters in that loop. The 
SP40 splitter is always the first splitter connected to the RS485 digital control loop. Notice on Figure 1 that the 
Individual and Fixed Zone Group codes are listed for a CLASS “A” splitter configuration. The SPB-160 is used 
as an example of an audio booster. 
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If the paging zones are set for CLASS “B” then the warehouse Individual Zone Codes will be “01” through 
“04”, and the front office Individual Zone Codes will be “05” through “08”. The Fixed Zone Group Code for 
the warehouse will still be “71”, and the front office Fixed Zone Group Code will still be “72”. See Figure 2 for 
a CLASS “B” example. 
 

INDIVIDUAL 
ZONE CODES = 
01,02,03,04

FIXED ZONE 
CODE = 71

INDIVIDUAL 
ZONE CODES = 
05,06,07,08

FIXED ZONE 
CODE = 72

INDIVIDUAL 
ZONE CODES = 
09,10,11,12

FIXED ZONE 
CODE = 73

INDIVIDUAL 
ZONE CODES = 
13,14,15,16

FIXED ZONE 
CODE = 74

INDIVIDUAL 
ZONE CODES = 
17,18,19,20

FIXED ZONE 
CODE = 75

SP4-TZC

SP4-APS SP4-APS SP4-APS SP4-APS SP4-APS

SP40/2 SPB-160 SPB-160

#1 #2 #3 #4 #5

RS485

RS485 RS485 RS485 RS485 TO ADDITIONAL 
SP4-APS SPLITTERS

CONNECT THE SP4-TZC RS485 CONNECTION 
TO THE SP40 SP4-APS FIRST.  

 
Figure 2 

RS485 Communications Path from SP4-TZC to CLASS  “B” SP4-APS Splitters 
 
NOTE:  2 CLASS “A” or 4 CLASS “B” Zone Codes are assigned to each splitter. If a zone audio 
 output is not used the Zone Code remains with that splitters.  
 
Appendix A, in the back of this manual, is a Telephone Page Zone Control Mapping Guide which can be used 
to map the zone locations and Zone Codes. This can assist the technician as well as the user in identifying the 
locations of the paging zones. 
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1.2 Connections 
Figure 3 shows the layout of the SP4-TZC PC Board. 

RS485
COM Port

NOTE: OBSERVE
CORRECT POLARITY

Audio 
Output

24VDC
Input

Background 
Music Input

Telephone 
Input

Microprocessor
Alignment Marker

System Reset
Switch

Power On
LED Indicator

(Green)

Page Level
Led Indicators

Page Volume
Adjust

Alert Page
Tone Selection

Jumper

BGM 
Volume
Adjust

Microprocessor
PC Board

Status
LED Indicators

(Green)

Communication
LED Indicator

(Green)

Diagnostic
LED Indicator

(Amber)

 
 

Figure 3  
SP4-TZC PC Board Layout 
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NOTE:  The Microprocessor PC Board should not be removed from the main PC board. If it has been 
 removed, install it by using the Microprocessor alignment marker shown in Figure 3. 
 Make sure that all pins on the PC board are properly aligned. 
 

1.2.1 Power 
The SP4-TZC is powered by a separate 24VDC filtered and regulated power supply which can provide a 
minimum of 150mA of current. The Wheelock RPS-2406 is a good choice. 
 

1.2.2 USB Port 
The USB port is used to program the 9 Logical Zone Groups and Background Music (BGM) using the SP4 
Telzone Programmer 2 software included.  The default (out of the box) configuration for the SP4-TZC is that 
all zones have BGM. To program using the USB port, connect an interface cable from the host computer’s 
USB ports to the USB Series “B” receptacle located on the SP4-TZC. The USB cable should not exceed 10 
feet in length. This cable can be purchased using Cooper Wheelock Part Number TZC-USB (109923). The 
SP4 Telzone Programmer 2 software can also be downloaded from the Cooper Wheelock website 
(www.wheelockinc.com). 
 

1.2.3 Telephone Input 
The PHONE IN (Telephone Input) can accept three different types of devices to activate an audio page: a 
stand-alone telephone, an unused C.O. port, or a page port.  The SP4-TZC provides the stand-alone telephone 
and unused C.O. port with loop start current in order to operate and provide DTMF tones. The page port must 
provide 600 Ohm impedance, provide a dry contact, pass loop current, and allow the DTMF tones to pass.  

1.2.4 Background Music Input 
The monaural Background Music Input shall be a Line Level Signal of 300mVrms at 600 Ohms. Background 
Music will be automatically muted during a telephone page. 

1.2.5 Audio Out 
The Audio Out connects the to the SP40 BGM input.  

1.2.6 RS485 Digital Control Port 
The RS485 Digital Control Port connects to the digital control loop for the SP4-APS splitters.   

 

1.3 Enclosure 
The SP4-TZC PC board is mounted in its own enclosure and is designed for indoor use only. Normally, it is 
mounted next to the SP40 enclosure. The separate 24VDC power supply is mounted outside of the enclosure. 
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1.4 Specifications 
The SP4-TZC specifications are listed in Table 2 below. 
 

Table 2 
SP4-TZC Specifications 

Specification Value 

Input Voltage 24 VDC 

Maximum Current 73mA 

Page Input Voltage 550mVrms 

BGM Input Voltage 
Monaural 

300mVrms at 600 Ohms 

Maximum Distance between 
SP4-TZC and the first SP4-
APS splitter using #18AWG 
wire. 

2000 ft. 

 
 
The SP4-TZC factory default settings are listed in Table 3 below. 

 
Table 3 

Factory Default Settings 

 

1.4.1 Wiring Specifications 
Cable size: All terminal blocks accept #12 - #18 American Wire Gauge (AWG) for single wire connection. 

Setting Factory Default 
Zone Paging (Individual Zone and Fixed Zone Group telephone paging) Enabled 
Logical Zone Group paging Disabled 
Background Music All Zones 
Silence Detection Timeout 10 seconds 
Maximum Paging Duration 1 minute 
Alert Page Tone ON (Positions 1-2 Alert Page Tone)
BGM Volume Full Clockwise (Max Volume) 
Page Volume Full Clockwise (Max Volume) 
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Chapter 2 
Installation Procedures 
 

2.1 Notes, Cautions, and Warnings 
 

NOTE:  All CAUTIONS and WARNINGS are identified by the symbol .  All warnings are printed in bold 
capital letters. 

 
 

WARNING:  PLEASE READ THESE INSTRUCTIONS CAREFULLY BEFORE USING THIS 
PRODUCT. FAILURE TO COMPLY WITH ANY OF THE FOLLOWING 
INSTRUCTIONS, CAUTIONS AND WARNINGS COULD RESULT IN IMPROPER 
APPLICATION, INSTALLATION AND/OR OPERATION OF THESE PRODUCTS 
IN AN EMERGENCY SITUATION, WHICH COULD RESULT IN PROPERTY 
DAMAGE AND SERIOUS INJURY OR DEATH TO YOU AND/OR OTHERS. 

 
NOTE: Observe all electrical and electronic safety precautions. 
 
This manual assumes that the SP40 has been installed according to the SP40 Installation Manual 
(P84116) and that the SP4-APS splitter is properly installed according to the SP4-APS Installation 
Procedure (P84577) in the SP40 enclosure.  It also assumes that all Audio Boosters (SPB-80/4, SPB-160, 
SPB-320) are properly wired according to the SPB-80/4 and SPB-160 Audio Booster Installation Manual 
(P84296) and/or the SPB-320 (P84244) Installation Manual, and that the SP4-APS splitters are properly 
installed. 
 

WARNING:  BEFORE INSTALLING THE SP4-TZC ZONE CONTROLLER, MAKE SURE THE 
POWER IS TURNED OFF AND BATTERIES REMOVED TO ALL COMPONENTS 
OF THE SAFEPATH®4 MULTI-FUNCTIONAL FACILITY COMMUNICATIONS 
SYSTEM. 

2.2 Telephone Page Zone Control Mapping Guide 
Appendix A, at the back of this manual is a Telephone Page Zone Control Mapping Guide which can be used to 
map the zone locations and Zone Codes. This can assist the technician as well as the user in identifying the 
locations of the paging zones. The user can create a directory from this guide. 

2.3 Mounting 
 

Perform the following steps using Figure 4 as a reference: 

 

Remove the 4 sheet metal screws from the front cover and remove the front cover.  

 

Mount the SP4-TZC to the wall next to the SP40 enclosure using the two keyholes and the two 
circular holes provided in the base.  Be sure to use mounting hardware suitable for the mounting 
surface. 

 

As required, remove the 3/4" knockouts on the top and bottom of the enclosure for conduit or wire 
runs. 

STEP 1

STEP 2

STEP 3
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SHEET METAL SCREW 
PHILLIPS 1/4" x 3/8" 
BLACK (4)

COVER 6.00"
3/4" KNOCKOUTS

11.00"

3/4" KNOCKOUTS

 
 

Figure 4 
Mounting diagram 

 
 

Leave the cover off until all wiring and testing has been completed. 
 
 
 
Mount the external 24VDC Power Supply near the SP4-TZC. Do not connect the wiring to the 
SP4-TZC at this time. 

STEP 4

STEP 5
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2.4 Wiring the SP4-TZC Zone Controller 
This Section describes the wiring of the SP4-TZC Zone Controller.  Following the sequence of Section numbers 
will ensure a proper installation. 
 

2.4.1 Removable Terminal Block 
 

The terminal blocks on the SP4-TZC are removable. To remove a terminal block, pull the block horizontally 
from the circuit board as shown in Figure 5. Attach each wire to its proper connections, and plug the 
terminal block back on the board being careful to match and align the pins.  

 

 
Figure 5  

Removable Terminal Block 
 

2.4.2 Wiring the SP4-TZC Zone Controller 

2.4.2.1 Wiring Connections for SP4-TZC to SP40 and an SP4-APS 
 

To wire the SP4-TZC to the SP40 with one SP4-APS, refer to Appendix B in the back of this manual. 

2.4.2.2 Wiring Connection for SP4-TZC to SP40 with an SP4-APS and 
Audio Boosters with Multiple SP4-APS Splitters 

 
SPB-160 
To wire the SP4-TZC to the SP40 with one SP4-APS splitter and an Audio Booster with multiple SP4-
APS splitters, refer to Appendix C in the back of the manual.  The diagram uses an SPB-160 Audio 
Booster because it has two Audio Outputs with a splitter on each.  
 
SPB-80/4 
The SPB-80/4 Audio Booster has the same audio terminals as the SPB-160, except that it has a single 
audio output. Use Appendix C and follow the same wiring sequence as the SPB-160 with a single SP4-
APS.  

 
2.4.2.3 Wiring Connections for SP4-TZC with the SP40, 

Multiple SPB-160s and Multiple SP4-APS Splitters 
 

SPB-160 
Appendix D in the back of this manual shows the proper wiring of the SP4-TZC connected to an SP40 and 
two SPB-160s with multiple SP4-APS splitters. 
 
SPB-320 
Appendix D in the back of this manual also shows the proper wiring of the SP4-TZC connected to an 
SP40 and two SPB-160s with multiple SP4-APS splitters located in the SPB-320 enclosure. 
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2.4.3 Wiring the Paging Telephone to the SP4-TZC 
 

Connect to the PHONE IN terminal using either Section 2.4.3.1 “Stand-Alone Telephone or 
Unused CO Port Wiring” or Section 2.4.3.2 “Audio Page Port Wiring”. 

 

2.4.3.1 Stand-Alone Telephone or Unused CO Port Wiring 
 

If a stand-alone telephone or an unused CO port on a telephone system is used, wire the Tip and Ring 
wires directly to the PHONE IN terminals. The Tip wire is usually green and the Ring wire is usually 
red. See Figure 6 for the location of the connection on the SP4-TZC. 

 

 
Figure 6 

Stand Alone Telephone or Unused CO Port Wiring 
 

2.4.3.2 Audio Page Port Wiring 
 

If the SP4-TZC is to be connected to an audio page port, the Audio Page Port must provide: 
 

 (A)  A 600 Ohm, low power page output, capable of passing DC loop current. 
 (B)  Transmission of DTMF tones (touch-tone). 
 (C) A dry contact that is normally open, closes when paging and reopens when the page is 

completed. 
 

If these conditions are met, then connect Tip and Ring as shown in Figure 7. 
 

    SP4-TZC
Telephone InputTelephone System 

  Audio Page Port

TIP

RING

DRY 
CONTACT

(600 OHM OUTPUT)

 
Figure 7 

Connecting to a 600 Ohm Audio Page Port 

STEP 6
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2.4.4 Wiring the Background Music Input 
 

Connect the Background Music source to the BGM INPUT terminals. See Figure 8. 
 
 

NOTE:  The Background Music Input shall be a Line Level Signal 2.5V P-P or 300mVrms at 600 Ohms 
 signal.  

 

 Background 
Music Source  

Figure 8 
Connecting the Background Music 

 
 

2.4.5 Connecting the AUDIO OUT Output 
 

Connect the AUDIO OUT from the SP4-TZC to the BGM terminals on the SP40. See Figure 9. 

STEP 7

STEP 8
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CC

OUT IN OUT IN

OUT IN
24 VDC AUDIO

RS-485 ALARM

POWER TROUBLE

Z1 Z2 Z3 Z4 EX1 EX2

INCLASS
B

A

NAC
CC

SW1

SW2

USB

SP4-TZC

SP40

SP4-APS

J3

_

_

+_
+

+

TB6

_

_

+_
+

+
TB4

TB3

_

_

+_
+

+
TB2

_

_

+_
+

+
TB5

STB OUT

RET

STB IN

NO
NC

A
L
M

T
R
B

NO
NC

COM

IN3

IN2

IN1

NR

TEL

BGM

AUDIO OUT

CC/NAC

AUX IN

_+ 24
V

NO

COMCOM

JP1

AUDIO OUT 
TO SP40 BGM

RS485 COM1 TO 
SP4-APS RS485 IN

BGM

             NOTE:
OBSERVE CORRECT 
          POLARITY

 
Figure 9 

Audio Out and RS485 Wiring Connections 
 

2.4.6 RS485 Digital Control Port Connection 
 

Connect the RS485 Digital Control Port terminals from the SP4-TZC to the RS485 IN terminals 
on the SP4-APS splitter. See Figure 9. Observe correct polarity.  

2.4.7 RS485 Digital Control Port Connection to Other SP4-APS Splitters 
Connect the RS485 OUT from the SP4-APS splitter to the RS485 IN on the next SP4-APS splitter 
connected to an audio booster (SPB-80/4, SPB-160, SPB-320). Observe proper polarity. 

NOTE:   Refer to Section 1.1, Figures 1 and 2. These figures show the order of the connections of the 
splitters.  

STEP 9

STEP 10
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2.5 Powering, Adjusting, and Testing the SAFEPATH®4             
Multi-Function Facility Communications System 

When all wiring is completed it is time to apply power to the SAFEPATH®4  Multi-Function Facility 
Communications System.  Adjust and test the SP4-TZC Zone Controller and the SP4-APS splitters. 

2.5.1 Alert Page Tone Selection Jumper Setting 
 

If no alert tone is desired, place the jumper on pins 2 and 3 of JP1. (Factory Default is Alert Tone 
enabled, with the jumper between pins 1 and 2).  See Figure 10 for the location of the Alert Page 
Tone Selection Jumper. 

 

+

-

Alert Page
Tone 

Selection
Jumper

 
Figure 10 

Alert Page Tone Selection Jumper 
 

NOTE: The volume of the Alert Tone is not adjustable. 
 

2.5.2 Power Input 
NOTE: Make sure power is applied to the SP40 and all the Audio Boosters. 

 
WARNING:  WHEN APPLYING POWER TO THE SP40 AND THE AUDIO BOOSTERS, ALWAYS 

APPLY AC POWER BEFORE APPLYING BATTERY POWER. WHEN REMOVING 
POWER, REMOVE THE BATTERY POWER BEFORE  REMOVING THE AC POWER. 

 

Connect the previously mounted 24VDC Power Supply to the POWER input on the SP4-TZC. Observe 
correct polarity. See Figure 11. 

 

STEP 1

STEP 1
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24VDC
Power Supply

 
Figure 11 

24VDC Connection to the SP4-TZC 
 

Apply power to the 24VDC Power Supply. The “POWER” LED indicator will turn ON. The 
“RS485 COM1 ACTIVE” LED indicator should be BLINKING. The “STANDBY/RUN” LED 
will BLINK for a maximum of 1 minute before becoming solid ON.  See Figure 12 for LED 
indicator locations. 
 

NOTE:  If an SP4-APS splitter is not energized during this process, the SP4-TZC will not “see” it and will go 
on to the next splitter. This will affect the order of the Zone Codes. 

 
NOTE:  If the “TROUBLE” LED indicator is ON, and the “SPLITTER MISMATCH” LED indicator is ON, 

one or more of the CLASS switches on the SP4-APS splitters is in the wrong position. See Figure 12 
for LED indicator locations. Check the CLASS switch on each splitter and make sure all are in CLASS 
“A” or CLASS “B” as desired.  

 

Standby/Run
LED (Green)

Power On
LED (Green)

RS485 COM1
Active LED (Green)

Trouble
LED (Amber)

Splitter Mismatch
LED (Amber)

 
Figure 12 

SP4-TZC LED Indicators 
 

STEP 2
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2.5.3 Adjustments on the SP4-TZC Zone Controller 
 
The SP4-TZC has two adjustments described in Table 3.   
 
 Table 4  

SP4-TZC Adjustments 

Adjustment Results 

BGM Volume Adjust (R17) Clockwise for Volume Increase 
Page Volume Adjust (R7) Clockwise for Volume Increase 

 
The page level is set using the "Page Volume" control on the SP4-TZC. Ideal signal level (during a page) occurs 
when green/yellow Page Level LED's are constantly lit with an occasional flicker of the red Page Level LED. 
Once the Page Level is set, bring up the BGM (Background Music) level control on the SP40S. Set the volume 
during a telephone page to a level that produces clear, audible paging. 
 
The background music level is set using the "BGM Volume" control on the SP4-TZC. 
 
Refer to Figure 13 for the locations of these volume adjustments. 
 

Page Volume
Adjust

BGM 
Volume
Adjust

 
 

Figure 13 
SP4-TZC Adjustment Locations 

 

2.5.4 Testing the SAFEPATH®4  Multi-Function Facility 
 Communications System Paging Function 
 

In the “factory default” configuration, the paging function will only allow Individual Zones and Fixed Zone 
Groups to operate. Background Music will be broadcast on all Individual Zones. In order to program Logical 
Zone Groups and edit the Individual Zones for Background Music the SP4 Telzone Programmer 2 software 
must be used. The installation and use of the SP4 Telzone Programmer 2 software is described in Chapter 3. 
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Calculate the number of Individual Zones available. The number of Individual  CLASS “B” Zones 
available equals the number of SP4-APS splitters times 4. The number of Individual  CLASS “A”  
Zones equals the number of SP4-APS splitters times 2. 
 
 

CLASS x (# of SP4-APS splitters) =  # of Individual Zones Available 
 

Where Class Equals 
 Class  “A” = 2 
 Class  “B” = 4 
 

Examples: 
 

If I had 12 SP4-APS splitters, in order to calculate the number of CLASS “B” zones I would multiply the 
number of splitters by 4.  The result would be 48 Individual Zones. 
 

In order to calculate the number of CLASS “A” zones, I would multiply the number of splitters by 2.  The result 
would be 24 Individual Zones. 
 
 

Test each Individual Zone and each Fixed Zone Group as follows: 
 

• Pick up the telephone and connect to the SP4-TZC Zone Controller. 
 

 You will hear – Access Tone (500 milliseconds ON) 
 Audio Output – None 

 
• Key the 2 digit Zone Code for the desired Individual Zone or Fixed Zone Group. 

 

 You will hear – Page Ready Tone (500 milliseconds ON) 
 Audio Output – Selected Individual Fixed Zone or Individual Fixed Zone Group will hear 

the alert tone if enabled as described in Section 2.5.1. 
 

NOTE:  If an invalid or unused 2 digit Zone Code is entered the operator will hear 3 short tones (100 
milliseconds ON and 100 milliseconds OFF) followed by 1 long tone (500 milliseconds ON). The long tone 
indicates that the paging system has been reset allowing you to enter another Zone Code. There is no audio 
output when an invalid or unused Zone Code is entered. 
 

• Make the announcement. 
 

 Audio Output – Message will be broadcast to the selected Individual Zone or Fixed Zone 
Group. 

 
NOTE:  When paging, Background Music will be muted on all zones.   
 

• At the conclusion of the page, simply hang-up the telephone handset. Background Music will 
automatically be restored. 

 
 
Replace the front cover of the SP4-TZC Zone Controller using the 4 screws to hold the cover in 
place. See Figure 4 for details.  

 
The SAFEPATH®4  Multi-Function Facility Communications System Paging Function is ready for 
operation. 

STEP 1

STEP 2

STEP 3
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Chapter 3 
SP4 Telzone Programmer 2 Software 
3.1 About the SP4 Telzone Programmer 2 Software 
 
The SP4 Telzone Programmer 2 software is the second major release of the software, that is designed to operate 
with an SP4-TZC having firmware version 2.xx. It is NOT backwards compatible with an SP4-TZC having 
firmware version 1.xx. For SP4-TZC's having firmware version 1.xx, version 1.x.x.x of the SP4 Telzone 
Programmer software must be used to ensure proper operation. 
 
The SP4 Telzone Programmer 2 software is used to modify SP4-TZC Zone Paging system settings and options, 
and to customize the Individual Zones for Background Music (BGM). Communication with the SP4-TZC is 
achieved via the USB port of the host computer. 
 
By default, Zone Paging is enabled, in which case Individual Zone, Fixed Zone Group, and Logical Zone Group 
paging can be carried out. A maximum of 9 Logical Zone Groups can be programmed using the SP4 Telzone 
Programmer software. Each can combine up to five Individual Zones and/or Fixed Zone Groups. 
 
Zone Paging can be disabled by using the software, in which case the paging system reverts to only All-Call 
paging. 
 
Also, Individual Zones can be selected or deselected for Background Music (BGM) using the SP Telzone 
Programmer software. 
 
The SP4 Telzone Programmer 2 folder containing the files, is located on the hard drive of the computer in the 
“Program Files” Folder, in the folder labeled “Cooper Wheelock”.  
 
Refer to the following table for compatibility between the SP4-TZC and SP4 Telzone Programmer software 
versions: 

Table 5 
Major Version SP4-TZ Firmware Version SP4-Telzone Programmer 

Software Version 
Version 1 1.xx 1.x.x.x 
Version 2 2.xx 2.x.x.x 

3.2 Installing the SP4 Telzone Programmer 2 Software 
The host computer operating system for the SP4 Telzone Programmer 2 software program shall be Microsoft 
Windows 2000 Professional with Service Pack 2 or above, or Microsoft Windows XP Professional with Service 
Pack 1 or 2.  
 

NOTE:  The person installing this software must be logged on as an “Administrator” or must have 
administrative privileges for the host computer.  

 
To install the SP4 Telzone Programmer 2 software, proceed as follows: 
 

Make certain that you close all software that is running on the host computer, and that the USB 
cable is not connected to the SP4-TZC. 

 

Insert the SP4 Telzone Programmer 2 software CD into the CD-ROM drive.   

STEP 1

STEP 2
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Double click on the “Computer Icon”    and then double click on the CD-ROM drive.  

    

Double click on the Setup.exe file.  

Follow the instructions on each screen. Complete the installation by pressing the FINISH button 
on the final screen.  

At the completion of the installation process the SP4 Telzone Programmer 2 Icon  will appear on 
your Desktop screen, Start menu, and Programs list. 

3.3 Installing the USB Driver 
After the SP4 Telzone Programmer 2 software has been installed on the host computer, the proper USB driver 
must be installed. The following is the procedure: 
 

Insert the SP4 Telzone Programmer 2 software CD in the CD-ROM drive on the host computer. 
Take note of the USB port on the host computer connected to the SP4-TZC, as this USB port will 
be configured for operation with the SP4-TZC. 

Connect the USB cable between the USB port of the host computer and the SP4-TZC’s USB port. 

 

NOTE:  When connecting to other USB ports on the host computer for which the USB driver has not been 
installed, the SP4 Telzone Programmer 2 will be unable to communicate with the SP4-TZC. 

NOTE:  The USB cable cannot exceed 10 feet in length. See Section 1.2.2 for a description of the connectors 
on the USB cable. 

 

Apply power to the SP4-TZC by energizing the separate 24VDC power supply. 

 

The “Found New Hardware” wizard indicates that new hardware has been found, and prompts the 
user for the location of the USB driver. Locate the USB driver on the SP4 Telzone Programmer 2 
software CD. Follow the directions on the screen to complete the installation of the USB driver. 

3.4 SP4 Telzone Programmer 2 Main Screen 
Refer to Figure 14 for the explanation of areas of the SP4 Telzone Programmer 2 main screen. 

3.4.1 Menu Bar  
Traditional Windows style Menu Bar where you can access all the SP4 Telzone Programmer 2 software 
features.  See Figure below. 

 
 
 

STEP 3

STEP 4

STEP 5

STEP 1

STEP 2

STEP 3

STEP 4
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3.4.1.1 File Menu 

Contains menu items and keyboard shortcuts to create a new setup using the SP4 Telzone Programmer 2 
wizard, open an existing SP4 Telzone Programmer 2 setup file, and save changes. It also lists current SP4 
Telzone Programmer 2 setup files that are in the system.  See Figure below. 

 
 

 
Figure 14 

SP4 Telzone Programmer 2 Main Screen 

3.4.1.2 Edit Menu 

Contains menu items and keyboard shortcuts used to edit the Logical Zone Group labels. In the Figure 
below some of the Edit menu items are not active.  As soon as a name is entered in the Logical Zone Group 
label box, these menu items become active. 

 



 
 

24

3.4.1.3 View Menu 
Allows you to view or hide the Status Bar at the bottom of the screen.  See Figure below. 

 

3.4.1.4 Zone Setup Menu 
Opens the Background Music or the Options screen.  See Figure below. 

 

3.4.1.5 System Info Menu 
The System Info has 3 items in its menu. Each of these items are displayed on the Output Screen.  See 
Figure below. 

 
 

NOTE: To erase the Output Screen, click on the Clear output command button. 

The “Firmware” item displays the firmware version of the SP4-TZC Zone Controller and detected SP4-
APS splitters on the Output Screen. The firmware version of the SP4-TZC Zone Controller does not have 
to match the SP4-APS splitters firmware version.   See Figure below. 

 

The “Splitter Serial Numbers” item displays the electronic serial number of detected each SP4-APS 
splitter on the Output Screen.  See Figure below. 

 

The order of the serial numbers does not matter for paging operation. The order that the SP4-APS splitters 
are placed in the circuit, determines the Zone Code. 

 

The “Splitter Status” item displays normal and/or trouble conditions for detected SP4-APS splitters on the 
Output Screen.  See Figure below.  This screen can be used to troubleshoot the SP4-APS splitters, when a 
trouble condition cannot be resolved using the LED indicators on the SP4-APS splitter circuit board.  See 
Table 7 in Section 5.7. 
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3.4.1.6 Help Menu 

Opens the Help screens and the “About the SP4 Telzone Programmer 2” display. 
 

3.4.2 “Get Configuration” Command Button 
 

The “Get Configuration” command button queries the SP4-TZC to obtain current operating configuration 
and displays it on screen. This command can also be activated using the Ctrl + Alt + G keyboard shortcut. 
 
If the SP4-TZC was not previously programmed by the SP4 Telzone Programmer software, the “Get 
Configuration” command button will query and display the current network configuration and default Zone 
Paging system settings. If the SP4-TZC was previously programmed using the SP4 Telzone Programmer 
software, the “Get Configuration” command button will query and display the current network 
configuration and previously downloaded configuration. 

 
NOTE:  Executing this command will overwrite the current setup on the main screen. Before clicking the “Get 

Configuration” command button you may choose to save the current SP4 Telzone Programmer 2 
setup by clicking File-> Save or File->Save As… menu options. 

3.4.3 “Send Configuration” Command Button 

The “Send Configuration” command button is used to send the configured Zone Paging system settings and 
options (which includes the Logical Zone Groups and Background Music zone configuration) to the SP4-
TZC.  This command can also be activated using the Ctrl + Alt + S keyboard shortcut. 

When this configuration is successfully sent, it replaces any existing configuration on the SP4-TZC with the 
newly downloaded configuration. 

3.5 Programming and Editing Logical Zone Groups and the 
Background Music Zone 
The SP4 Telzone Programmer 2 software programs the Logical Zone Groups. In review, a Logical Zone Group 
consists of as many as five Individual Zones and/or Fixed Zone Groups. For example, let’s say you wanted to 
page the warehouse, the warehouse office and the loading dock using one Zone Code. This can be done by 
programming a Logical Zone Group containing these zones. Programming Logical Zone Groups can be done 
using the wizard feature or manually.  Let’s look at the wizard feature and then the manual feature. 

3.5.1 Programming Logical Zone Groups and the Background Music 
Zone Using the Wizard Feature 

The SP4 Telzone Programmer 2 software contains a wizard feature, used for creating a new setup file.  

Connect the USB cable from the USB port on the SP4-TZC Zone Controller to the configured 
USB port on the host computer.  Make sure that the SP40, all Audio Boosters and SP4-APS 
splitters are properly connected and powered up. 

 

Start the SP4 Telzone Programmer 2 software. 
 

NOTE: Before creating a new Setup file, always save the current setup file. 

 

Run the wizard by opening the File menu and clicking the New menu option. The following 
screens will open: 

STEP 3

STEP 1

STEP 2
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Type in the desired file name. (Example “Granit Hills”) 
 
 

NOTE:  Do not choose the factory default file “fdefault”.  The wizard will not allow you to make any changes 
to it. A different name must be used, otherwise the Warning message in the following screen will 
appear:  

 

 
 
 

Click the “Next” command button. The following screen will appear: 
 

 
 

Select the “Audio Class of wiring” for this installation (CLASS “A” or CLASS “B”). 

STEP 4

STEP 5

STEP 6
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Enter the number of SP4-APS splitters used. The maximum number of splitters is 17. 
 
 

  NOTE:  When the splitters are set to CLASS “A” the maximum number of Individual Zones is two per 
splitter with a maximum of 34 per system. When the splitters are set to CLASS “B” the maximum 
number of Individual Zones is four per splitter with a maximum number of 68 per system. 
Remember, all SP4-APS splitter “Audio Class of wiring” settings must be the same. 

 

Choose from the following Zone Paging pull-down menu selections (Enabled or Disabled). 

 

NOTE:     If Zone Paging is Disabled, the paging system will default to All-Call telephone paging. All 
Individual Zone, Fixed Zone Group, and Logical Zone Group paging will be disabled. Also, all 
Logical Zone Group programming will be disabled on the main screen. 

 

Click the “Next” command button. The following “Background Music Setup” screen will 
appear: 
 
 

 
 

Notice that 12 of the boxes are white. This represents active zones. This would be correct when 
the “Audio Class of wiring” was set to CLASS “B” and the “Number of Splitters” was set to 3. 

 
NOTE:  When the “Clear All” command button is selected, all check marks  are removed from the 
 zone boxes. When the “Set All” command button is selected, all zone boxes will contain a 
 check mark. 

Edit the “Background Music Setup” to play on the desired Individual Zones. The check mark 
 indicates that the Background Music will play on the indicated Individual Zone.  

 

 

 

 

 
 

STEP 7

STEP 8

STEP 9

STEP 10
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 Click the “Finish” command button. The main screen will appear. See Figure below. 

 

 
 

To skip programming of Logical Zone Groups, or if Zone Paging is Disabled, go to STEP 14. 
Otherwise enter the name of the Logical Zone Groups and enter the Zone Codes for the Individual 
Zones and/or Fixed Zone Groups for each Logical Zone Group. 

 
Enter the name of the Logical Zone Groups and enter the Zone Codes for the Individual Zones 
and/or Fixed Zone Groups for each Logical Zone Group. 

 

 
Save the file by opening the File menu and clicking Save. The following screen will appear: 

 

 
 

 
Verify the file name before saving, and then click the Save button. 

 
 

In order to configure the SP4-TZC Zone Controller with the new setup, click the “Send 
Configuration” command button. If an Error message appears, refer to Section 5.6 for details and 
corrective action.  

 

STEP 15

STEP 16

STEP 11

STEP 12

STEP 13

STEP 14
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Click the OK button on the “Zone Controller Successfully Programmed” message. 

 
 

Close the SP4 Telzone Programmer 2 software. 
 

 
Disconnect the USB cable from the SP4-TZC Zone Controller and the host computer.  
 

 

3.5.2 Manually Programming/Editing Logical Zone Groups 
Connect the USB cable from the USB port on the SP4-TZC Zone Controller to the configured 
USB port on the host computer.  Make sure that the SP40, all Audio Boosters and SP4-APS 
splitters are properly connected and powered up. 

 

Start the SP4 Telzone Programmer 2 software. 

 
NOTE: Before creating a new setup file, always save the current file. 

 
Notice that the file name is Setup.tzc. Do one of the following: 

a. If you wish to obtain and view the present setup of Logical Zone Groups, click the “Get 
Configuration” command button.  Then proceed to Step 4. 

b. If you wish to select a previously saved setup file, select the File menu and click on 
Open. Select the desired file.  Then proceed to Step 4. 

c. If you wish to create a new setup file, select New from the File menu to open the Wizard 
and begin. Refer to section 3.5.1. 

 

 

STEP 1

STEP 2

STEP 3

STEP 17
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STEP 19
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Select the “Audio Class of wiring” for the connected SP4-APS splitters. Remember, all splitter 
“Class of Wiring” setting must be the same. 

 

Select the corresponding number of splitters in the “Number of Splitters” box. The maximum 
number of splitters is 17. 

 

 
 

In order to enable Logical Zone Group programming, ensure that the Zone Paging pull-down 
menu selection is set to "Enabled". If "Disabled", all Logical Zone Group programming will be 
disabled on the main screen. 

 

Edit the Logical Zone Groups as desired.  “Appendix A Telephone Page Zone Control Mapping 
Guide” can help identify the zone locations and Zone Codes.  Remember a Logical Zone Group 
can consist of up to 5 Individual Zones and/or Fixed Zone Groups.  See Figure above. 

 

Label the Logical Zone Groups by highlighting the name and typing over it with the new name. 
An example of a label might be “Warehouse” or “Front Office”.  See Figure above. 

 
When the editing of Logical Zone Groups has been completed, you may want to edit the 
Background Music Zone. If so, go to Section 3.6.1 for Background Music Zone editing.  If 
programming has been completed, open the File menu. Select Save As… 
 
 
 
 

 

STEP 4

STEP 5

STEP 8

STEP 9

STEP 6

STEP 7
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Enter the name of the file and click the Save button.  See Figure below. 
 

 
 

 
Complete the task by clicking on the “Send Configuration” command button. This sends the new 
configuration to the SP4-TZC. Notice that the “Zone Controller Successfully Programmed” 
message appears on the computer screen, and that the USB CONFIG LED indicator on the SP4-
TZC PC board turns ON. If an Error message appears, refer to Section 5.6 for details and 
corrective action. 
 
Click the “OK” button on the “Zone Controller Successfully Programmed” message. 
 
 
Test the Logical Zone Groups. 
 
 
Shut down the SP4 Telzone Programmer 2 software on the host computer. 

 
 

Disconnect the USB cable from the SP4-TZC Zone Controller and the host computer.  
 
 

3.5.3 Warning Message for Duplicate Zones 
The following Warning message will appear when a duplicate zone is selected in that Logical Zone Group. 
Remember, Individual Zones and Fixed Zone Groups can be used in more than one Logical Zone Group. 

Click the OK button.  The location of the duplicate zone will be highlighted in the Logical Zone Group and 
the zone number will default to zero. 
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3.6 SP4 Telzone Programmer 2 Background Music Setup 
 

The SP4 Telzone Programmer 2 “Background Music Setup” screen (Figure 15) is used to select or deselect 
Individual Zones for Background Music.  A checkmark  in the box indicates that the Individual Zone is 
selected for Background Music. Clicking on the box enables or disables Background Music for the Individual 
Zone. 

 
 

Figure 15 
Background Music Setup screen 

 

3.6.1 Editing Background Music 
 

Connect the USB cable from the USB port on the SP4-TZC Zone Controller to the configured 
USB port on the host computer.  Make sure that the SP40, all Audio Boosters and SP4-APS 
splitters are properly connected and powered up. 

 

Start the SP4 Telzone Programmer 2 software. 

 
NOTE: Before creating a new setup file, always save the current file. 

 
Notice that the file name is Setup.tzc. Do one of the following: 

a. If you wish to obtain and view the present setup of Individual Zones for Background 
Music, click the “Get Configuration” command button.  Then proceed to Step 4. 

b. If you wish to select a previously saved setup file, select the File menu and click on 
Open. Select the desired file.  Then proceed to Step 4. 

c. If you wish to create a new setup file, select New from the File menu to open the Wizard 
and begin. Refer to section 3.5.1. 

 

Select Background Music from the Zone Setup menu.  

 
 

Click the desired Individual Zones for editing to toggle the check mark  ON or OFF. 

 

NOTE:  By default, all Individual Zones are selected for Background Music. If Background Music is not 
desired on all zones click the “Clear All” command button. 

 

Clears all 
checkmarks from 
active zones. 

Sets all 
checkmarks in 
active zones 

White boxes 
indicate 
active zones. 
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When finished, click on the Apply button. 
 
Click the OK button. The “Background Music Setup” screen will close leaving the SP4 Telzone 
Programmer 2 main screen displayed. 

 
Save the file by opening the File menu and Save as the current file name, or Save As… with a 
new name. If a new name is chosen, notice that the file name is changed to the new name. 

 
Complete the task by clicking on the “Send Configuration” command button. This sends the new 
configuration to the SP4-TZC. Notice that the “Zone Controller Successfully Programmed” 
message appears on the computer screen, and that the USB CONFIG LED indicator on the SP4-
TZC PC board turns ON. If an Error message appears, refer to Section 5.6  for details and 
corrective action. 
 
Click the OK button on the “Zone Controller Successfully Programmed” message. 
 
 

Test the Individual Zones for Background Music.  
 
 
Shut down the SP4 Telzone Programmer 2 software on the host computer. 
 

 

Disconnect the USB cable from the SP4-TZC Zone Controller and the host computer.  
 

3.7 Zone Paging Setup (Default vs All-Call Paging) 
Connect the USB cable from the USB port on the SP4-TZC Zone Controller to the configured 
USB port on the host computer.  Make sure that the SP40, all Audio Boosters and SP4-APS 
splitters are properly connected and powered up. 

 

Start the SP4 Telzone Programmer 2 software. 

 
NOTE: Before creating a new setup file, always save the current file. 

 
Notice that the file name is Setup.tzc. Do one of the following: 

a. If you wish to obtain and view the present Zone Paging system settings, click the “Get 
Configuration” command button. Then proceed to Step 4. 

d. If you wish to select a previously saved setup file, select the File menu and click on 
Open. Select the desired file.  Then proceed to Step 4. 

e. If you wish to create a new setup file, select New from the File menu to open the Wizard 
and begin. Refer to section 3.5.1. 

 

Choose from the following Zone Paging pull-down menu selections (Enabled or Disabled). If 
"Disabled" go to Step 6. 

 
NOTE: If Zone Paging is Disabled, the paging system will default to All-Call telephone paging. All 
Individual Zone, Fixed Zone Group, and Logical Zone Group paging will be disabled. Also, all Logical Zone 
Group programming will be disabled on the main screen. 

 
Enter the name of the Logical Zone Groups and enter the Zone Codes for the Individual Zones 
and/or Fixed Zone Groups for each Logical Zone Group. 
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 When finished, open the File menu. Select Save As… 
 
Enter the name of the file and click the Save button.  See Figure below. 

 
 

Complete the task by clicking on the “Send Configuration” command button. This sends the new 
configuration to the SP4-TZC. Notice that the “Zone Controller Successfully Programmed” 
message appears on the computer screen, and that the USB CONFIG LED indicator on the SP4-
TZC PC board turns ON. If an Error message appears, refer to Section 5.6 for details and 
corrective action. 
 
Test the Zone Paging setup. 
 
 
Shut down the SP4 Telzone Programmer 2 software on the host computer. 

 
 

Disconnect the USB cable from the SP4-TZC Zone Controller and the host computer.  
 

3.8 Editing Silence Detection Timeout 
Connect the USB cable from the USB port on the SP4-TZC Zone Controller to the configured 
USB port on the host computer.  Make sure that the SP40, all audio boosters and SP4-APS 
splitters are properly connected and powered up. 

 

Start the SP4 Telzone Programmer 2 software. 

 
NOTE: Before creating a new setup file, always save the current file. 
 

 
Notice that the file name is Setup.tzc. Do one of the following: 

a. If you wish to obtain and view the present Zone Paging Options, click the “Get 
Configuration” command button. Then proceed to Step 4. 

b. If you wish to select a previously saved setup file, select the File menu and click on 
Open. Select the desired file. Then proceed to Step 4. 

c. If you wish to create a new setup file, select New from the File menu to open the Wizard 
and begin. Refer to section 3.5.1. 
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Select Options from the Zone Setup main menu located on the main screen. See Figure below. 

 

 
 
 Enter numeric Silence Detection Timeout value, from 3 to 30 seconds.  
 
 
When complete, click on the Apply button.  
 

 
Click the OK button. The “Options” screen will close leaving the SP4 Telzone Programmer 2 
main screen displayed. 
 
Save the file by opening the File menu and Save as the current file name, or Save As… with a 
new name. If a new name is chosen, notice that the file name is changed to the new name. 
 

 
Complete the task by clicking on the “Send Configuration” command button. This sends the new 
configuration to the SP4-TZC. Notice that the “Zone Controller Successfully Programmed” 
message appears on the computer screen, and that the USB CONFIG LED indicator on the SP4-
TZC PC board turns ON. If an Error message appears, refer to Section 5.6 for details and 
corrective action. 
 
 
Click the OK button on the “Zone Controller Successfully Programmed” message. 
 
 
Test the Silence Detection Timeout. 
 
 

Shut down the SP4 Telzone Programmer 2 software on the host computer. 
 

  

Disconnect the USB cable from the SP4-TZC Zone Controller and the host computer.  
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3.9 Editing Maximum Paging Duration 
Connect the USB cable from the USB port on the SP4-TZC Zone Controller to the configured 
USB port on the host computer.  Make sure that the SP40, all audio boosters and SP4-APS 
splitters are properly connected and powered up. 

 

Start the SP4 Telzone Programmer 2 software. 

 
NOTE: Before creating a new setup file, always save the current file. 

 
Notice that the file name is Setup.tzc. Do one of the following: 

a. If you wish to obtain and view the present Zone Paging Options, click the “Get 
Configuration” command button. Then proceed to Step 4. 

f. If you wish to select a previously saved setup file, select the File menu and click on 
Open. Select the desired file. Then proceed to Step 4. 

g. If you wish to create a new setup file, select New from the File menu to open the Wizard 
and begin. Refer to section 3.5.1. 

Select Options from the Zone Setup main menu located on the main screen. See Figure below. 

 
 

 
 
 

Check Maximum Paging Duration box to enable, or uncheck to disable. If disabled, go to STEP 7. 

 
 Enter numeric Maximum Paging Duration value in minutes from 1 to 60 minutes.  
 
When finished, click on the Apply button. 
 
Click the OK button. The “Options” screen will close leaving the SP4 Telzone Programmer 2 
main screen displayed. 
 
Save the file by opening the File menu and Save as the current file name, or Save As… with a 
new name. If a new name is chosen, notice that the file name is changed to the new name. 
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Complete the task by clicking on the “Send Configuration” command button. This sends the new 
configuration to the SP4-TZC. Notice that the “Zone Controller Successfully Programmed” 
message appears on the computer screen, and that the USB CONFIG LED indicator on the SP4-
TZC PC board turns ON. If an Error message appears, refer to Section 5.6 for details and 
corrective action. 
 
Click the OK button on the “Zone Controller Successfully Programmed” message. 
 
 

Test the Maximum Paging Duration. 
 
Shut down the SP4 Telzone Programmer 2 software on the host computer. 
 

  

Disconnect the USB cable from the SP4-TZC Zone Controller and the host computer. 
 

3.10 Uninstalling the SP4 Telzone Programmer 2 Software 
NOTE:  Make sure that the SP4 Telzone Programmer 2 software is not running on the host computer and that 

the USB cable has been disconnected from the SP4-TZC and the host computer. 

 

On the Windows screen click on Start→ Settings→ Control Panel→ Add/Remove Programs. 

 

Remove the SP4 Telzone Programmer 2 software.  

 
    
     NOTE:    Older versions of the SP4 Telzone Programmer software installed on the same host computer as 

newer versions of the software, may utilize the same USB Driver (FTDI FTD2XX) to communicate 
between the host computer and the SP4-TZC. 

 
 

Remove the USB Driver (FTDI FTD2XX). 
 
 
 
 
 
 

This completes the un-installation process. 

STEP 1

STEP 2

STEP 3

STEP 4

STEP 11

STEP 10

STEP 12

STEP 13

STEP 14
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Chapter 4 Paging Operation 

4.1 Making A Zone Page (Zone Paging Enabled) 
The following is the procedure for making a Zone Page using the SP4-TZC, with Zone Paging enabled. 
  

Pick up the Telephone and connect to the SP4-TZC Zone Controller. 
 

 You will hear – Access Tone (500 milliseconds ON) 
 Audio Output – None 

 
Key the 2 digit Zone Code for the desired zone location. 

 

 You will hear – Page Ready Tone (500 milliseconds ON) 
 Audio Output – Selected Zone or location will hear the alert tone if enabled. 
 
 

NOTE:  If an invalid or unused 2 digit Zone Code is entered the operator will hear 3 short tones (100 
milliseconds ON and 100 milliseconds OFF) followed by 1 long tone (500 milliseconds ON). The long 
tone indicates that the paging system has been reset allowing you to enter another Zone Code. There is 
no audio output when an invalid or unused Zone Code is entered. 

 
 

 
Make the announcement. 

 

 Audio Output – Message will be broadcast to the select zone location. 
 
NOTE:  When paging, Background Music will be muted in all zones.   
 

At the conclusion of the page, simply hang-up the telephone handset. The Background Music will 
automatically be restored. 
 

4.2 Making An All-Call Page (Zone Paging Disabled) 
The following is the procedure for making an All-Call Page using the SP4-TZC, with Zone Paging disabled 
using the SP4 Telzone Programmer software. 
  

Pick up the Telephone and connect to the SP4-TZC Zone Controller. 
 

 You will hear – Page Ready Tone (500 milliseconds ON) 
 Audio Output – All zones or locations will hear the alert tone if enabled. 

 
Make the announcement. 

 

 Audio Output – Message will be broadcast to all zones or locations. 
 
NOTE:  When paging, Background Music will be muted in all zones.   
 

At the conclusion of the page, simply hang-up the telephone handset. The Background Music will 
automatically be restored. 
 

STEP 1

STEP 2

STEP 3

STEP 4

STEP 1

STEP 3

STEP 2
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Chapter 5 Troubleshooting 
5.1 System Reset Switch 
The system reset switch is located above the RS485 COM1 port. The location is shown in Figure 16. It is used 
to reset the network configuration.  
 

System Reset
Switch

 
Figure 16 

Reset Switch Location 
 

5.1.1 Resetting the Network Configuration (Not SP4 Telzone 
Programmer 2 Programmed) 
 

Resetting the network configuration is done when it appears that the paging system is corrupt or an SP4-
APS splitter has been added, removed or replaced. Should one of these conditions occur, and the SP4-TZC 
has not been programmed using the SP4 Telzone Programmer 2 software, perform this procedure. If you 
have made changes, use Appendix A at the end of this manual to update the new Zone Code location for 
each zone and zone group. 

 
The procedure is as follows: 
 

Remove the enclosure cover from the SP4-TZC.  
 
 
Make sure 24VDC is ON to the SP4-TZC and all SP4-APS splitters. 
 
Press and hold the system reset button for approximately 5 seconds until the all LED indicators 
except the “POWER” LED indicator turns OFF.  

 
Release the system reset button. The SP4-TZC will begin finding and mapping the SP4-APS 
splitters.  The “RS485 COM1 ACTIVE” LED indicator should be BLINKING. The 
“STANDBY/RUN” LED will BLINK for a maximum of 1 minute after which the 
“STANDBY/RUN” LED will remain ON. 
 
Install the enclosure cover. 

 

STEP 1

STEP 2

STEP 3

STEP 4

STEP 5
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5.1.2 Resetting the Network Configuration (SP4 Telzone 
Programmer 2 Programmed) 

 

Resetting the network configuration is done when it appears that the paging system is corrupt or an SP4-
APS splitter has been added, removed or replaced. Should one of these conditions occur, and the SP4-TZC 
has been programmed using the SP4 Telzone Programmer 2 software (“USB CONFIG” LED indicator is 
BLINKING), perform one of these procedures. If you have made changes, use Appendix A at the end of 
this manual to update the new Zone Code location for each zone and zone group. 

 

If an SP4-APS splitter has been replaced or there appears to be corruption of the network, perform 
Procedure 1. If an SP4-APS splitter has been added or removed, perform Procedure 2. 
 

Procedure 1: Replacing an SP4-APS Splitter in the Same Location or if a Network Corruption has 
occurred. 
 
 

Remove the enclosure cover from the SP4-TZC. 
 
 
Make sure 24VDC is ON to the SP4-TZC and all SP4-APS splitters. Notice that the “USB 
CONFIG” LED indicator is BLINKING. 
 
Press and hold the system reset switch for approximately 5 seconds until the all LED indicators 
except the “POWER” LED indicator turn OFF.  

 
Release the system reset switch. The SP4-TZC will begin finding and mapping the SP4-APS 
splitters. The “RS485 COM1 ACTIVE” LED indicator should be BLINKING. The 
“STANDBY/RUN” LED indicator will BLINK for a maximum of 1 minute after which the 
“STANDBY/RUN” LED will remain ON.  The “USB CONFIG” LED indicator will change to 
solid ON. 
 
Install the enclosure cover. 
 

 
 Procedure 2: Adding or Removing SP4-APS Splitter(s) 

 

NOTE:  If an SP4-APS splitter(s) is being added, make sure its Class of Wiring switch (SW2) is in the same
 position as all the other SP4-APS splitters Class of Wiring switches. 

 
Remove the enclosure cover for the SP4-TZC. 
 
 
Make sure 24VDC is ON to the SP4-TZC and all SP4-APS splitters. Notice that the “USB 
CONFIG” LED indicator is BLINKING. 
 
Press and hold the system reset switch for approximately 5 seconds until the all LED indicators 
except the “POWER LED” indicator turn OFF.  

 
Release the system reset switch. The SP4-TZC will begin finding and mapping the SP4-APS 
splitters. The “RS485 COM1 ACTIVE” LED indicator should be BLINKING. The 
“STANDBY/RUN” LED indicator will BLINK for a maximum of 1 minute after which the 
“STANDBY/RUN” will remain ON. The “USB CONFIG” LED indicator will now be 
BLINKING. 

With the system operating, connect the USB cable between the SP4-TZC and the host computer 
containing the SP4 Telzone Programmer 2 software. 

STEP 1

STEP 2

STEP 3

STEP 4

STEP 5

STEP 1

STEP 2

STEP 3

STEP 4

STEP 5
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Launch the SP4 Telzone Programmer 2 software. The Setup file will appear on the main screen. 
 

NOTE:  If you want to download and edit the current SP4-TZC configuration, continue on to Step 7. (This 
will overwrite the SP4 Telzone Programmer 2 Setup file.) Otherwise, go to Section 3.5 to create and 
program new Logical Zone Groups and customize the Background Music Zone. 

 

Click the “Get Configuration” command button on the main screen.  
 

Click YES on the Warning message shown below.  
 

 
 
Click YES on the Error message shown below. 

 
 

Manually update the “Number of Splitters” box to the correct number of SP4-APS splitters on 
the network. 
 

NOTE:  If one or more SP4-APS splitters have been added or removed, the Individual Zone Codes, Fixed 
 Zone Group Codes, Logical Zone Group Codes, and the Background Music Zone may change. Use 
 Appendix A at the end of this manual to update the new Zone Code location for each zone and zone 
 group. 

 

Edit the Logical Zone Groups to reflect the changes made to the system, recorded in  
Appendix A. 
 

Edit the Background Music Zone to reflect the changes made to the system, recorded in Appendix 
A. 
 

Click the “Send Configuration” command button. Notice that the USB CONFIG LED indicator 
changes from BLINKING to solid ON.  
 

Click OK on the Information message shown below. 
 

 
 

NOTE:  If desired, click on File →Save and save the file as the Setup file, or Save as… and save the file with 
a desired name. 

 

Shut down the SP4 Telzone Programmer 2 software and remove the USB cable. If the enclosure 
cover has not be installed, install it now.  

STEP 6

STEP 7

STEP 8

STEP 9

STEP 10

STEP 11

STEP 12

STEP 13

STEP 14

STEP 15
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5.2 General Trouble Adjustments 
 
1. The system volume of the Background Music is too loud or too soft. Adjust R17 (BGM Volume Adjust) 

shown on Figure 17. 
 

2. The system volume of the page is too loud or too soft. Adjust R7 (Page Volume Adjust) shown on Figure 17. 
 

3. The state of the Alert Page Tone is ON or OFF and needs to be changed. Move the Alert Page Tone Selection 
Jumper (JP1) according to instructions found on the PC board. See Figure 17. 

+

-

Alert Page
Tone 

Selection
Jumper

BGM 
Volume
Adjust

Page 
Volume
Adjust

 
 

Figure 17 
General Trouble Adjustment Locations 

5.3 Troubleshooting Using Tone Patterns 
The SP4-TZC provides audio tone patterns to help you identify a trouble or the reason a page cannot be 
completed. The following table describes these conditions. 
 
 Table 6 
 Troubleshooting Using Tone Patterns 

Page Condition Indication From SP4-TZC 
Indication From 
SP4-APS 

Indication From 
SP40 

SP40 is in Alarm 
condition. No 
paging is allowed. 

Busy Signal. No page.  None None 

Open Zone being 
paged 

No indication. Page will be 
broadcast on all trouble free 
zones. 

Open LED indicator 
for that zone. 

TROUBLE and 
Audio Short LED 
indicators. 

Shorted Zone being 
paged 

3 short beeps followed by a 
long beep. Page will be 
broadcast on all trouble free 
zones. 

Short LED indicator 
for that zone. 

TROUBLE and 
Audio Short LED 
indicators. 

Invalid 2-digit 
Zone Code entered 

3 short beeps followed by a 
long beep.  

None None 
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5.4 Troubleshooting Using the Trouble LED Indicators on the PC 
Board 

The SP4-TZC PC board contains 2 status LED indicators (Green), 1 communication LED indicator (Green), 
and 3 diagnostic LED indicators (Amber). Figure 18 shows the location of these LED indicators on the PC 
board. If a trouble condition is detected, the amber “TROUBLE” LED indicator is ON.  
 

Status
LED Indicators

(Green)
Communication

LED Indicator
(Green)

Diagnostic
LED Indicators

(Amber)

 
Figure 18  

Location of the LED Indicators 

• If the SP4-APS splitter is connected to the SP40, the “TROUBLE” and “AUDIO SHORT” LED 
indicators on the SP40 will also be ON.  

• If the SP4-APS splitter is connected to an audio booster, the “TROUBLE” and “AUDIO SHORT” LED 
indicators on the audio booster will also be “ON”. 
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The following table describes the conditions of the LED indicators and if a problem is indicated, the solutions: 
 

Table 7 
Trouble LED Indicators 

 
Trouble LED LED Condition ON Problem Solution 

SPLITTER 
MISMATCH  

LED Indicator ON when all SP4-APS CLASS 
SW2 switch are not set the same. 

Check the CLASS SW2 
switch on all SP4-APS 
splitters and set them all as 
CLASS “A” or  CLASS “B” 
as applicable. 

Use the SP4 Telzone 
Programmer 2 software on the 
host computer to determine 
which SP4-APS splitter(s) are 
set to the wrong “Class of 
Wiring”. 

 
 
 
 
 
 
 
 

 
 
 

ON 
RS485 COMM LOSS 1. RS485 Connection to an SP4-APS is 

inoperative. The “RS485 COMM LOSS” LED 
indicator will BLINK a pattern indicating the 
ordered location of the inoperative splitter 
connection and above. All zones beyond the 
inoperative connection may not be able to be 
paged.  

2. An SP4-APS Power Loss: Green “POWER” 
LED will be OFF on the SP4-APS. “RS485 
COMM LOSS” LED will BLINK the number of 
times needed to identify the ordered location of 
the inoperative SP4-APS splitters. All zones on 
the SP4-APS splitter which has lost power will 
pass audio, even if the SP4-TZC requests the zone 
to be disconnected. All other splitters will function 
normally. 

1. Check the wiring. 

2. Check 24VDC power to the 
SP4-APS splitter. 
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5.5 Troubleshooting Using the “Get Configuration” Command 
Button 
 
The following Table shows the error messages that can occur and corrective procedures when the “Get 
Configuration” command button is used. 
 

Table 8 
“Get Configuration” Error Messages 

 
USB CONFIG 
LED Message Trouble Description Corrective Procedure 

Error: No splitters 
were detected. 
Display retrieved 
configuration 
anyway? Yes or No. 

After pressing the system 
reset button on the SP4-
TZC, the SP4-TZC could 
not detect any SP4-APS 
splitters on the network. 

Check the connection and polarity between 
the SP4-TZC RS485 COM Port and the first 
SP4-APS splitter. 
Perform the steps listed in Section 5.1.1 
“Resetting the Network Configuration (Not 
SP4 Telzone Programmer 2 Programmed)”  
or Section 5.1.2 “Resetting the Network 
Configuration (SP4 Telzone Programmer 2 
Programmed). 

Error: Detected a 
number of splitters 
mismatch with the 
Zone Controller 
configuration. 
Display Zone 
Controller 
configuration 
anyway? Yes or No. 

The SP4-TZC detected a 
mismatch with the 
number of SP4-APS 
splitters detected on the 
network. 

Check RS485 connection and polarity 
between each SP4-APS splitter on the 
network. 
Perform the steps listed in Section 5.1.1 
“Resetting the Network Configuration (Not 
SP4 Telzone Programmer 2 Programmed) ” 
or Section 5.1.2 “Resetting the Network 
Configuration (SP4 Telzone Programmer 2 
Programmed). 

Error: Detected an 
“Audio Class of 
wiring” mismatch 
with the Zone 
Controller 
configuration. 
Display Zone 
Controller 
configuration 
anyway? Yes or No. 

The SP4-TZC detected a 
mismatch with the “Class 
of Wiring” on one or 
more SP4-APS splitters 
on the network. 

Check that all SP4-APS splitters on the 
network have the same setting on the “Class 
of Wiring” switch. 
Perform the steps listed in Section 5.1.1 
“Resetting the Network Configuration (Not 
SP4 Telzone Programmer 2 Programmed) ”  
or Section 5.1.2 “Resetting the Network 
Configuration (SP4 Telzone Programmer 2 
Programmed). 

Blinking 

Error: Detected an 
“Audio Class of 
wiring” and “Number 
of Splitters” 
mismatch with the 
Zone Controller 
configuration. 
Display Zone 
Controller 
configuration 
anyway? Yes or No. 

A mismatch with the 
“Class of Wiring” on one 
or more SP4-APS 
splitters on the network. 
A mismatch with the 
number of SP4-APS 
splitters detected on the 
network. 

Check that all SP4-APS splitters on the 
network have the same setting on the “Class 
of Wiring” switch. 
Check RS485 connection and polarity 
between each SP4-APS splitter on the 
network. 
Perform the steps listed in Section 5.1.1 
“Resetting the Network Configuration (Not 
SP4 Telzone Programmer 2 Programmed) ”  
or Section 5.1.2 “Resetting the Network 
Configuration (SP4 Telzone Programmer 2 
Programmed). 
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5.6 “Send Configuration” Error Messages 
 
If “Audio Class of Wiring” and/or “Number of Splitters” inputs are entered incorrectly one of the 
following Error messages may appear: 

5.6.1 “Audio Class of Wiring Mismatch” 
If the incorrect “Audio Class of wiring” is selected the following message will appear: 

 
 

Check all the SP4-APS splitters and ensure that all the CLASS switches are set the same and match the 
“Class of Wiring” setting on the SP4 Telzone Programmer 2 main screen. 

5.6.2 “Splitters Mismatch” 

If the incorrect “Number of Splitters” is entered the following message will appear: 
 

 
 

Check to ensure that the number in the “Number of Splitters” box on the SP4 Telzone Programmer 2 
main screen matches the number of SP4-APS splitters detected by the SP4-TZC. 

5.6.3 “Audio Class of Wiring and Number of Splitters Mismatch” 

All SP4-APS splitters must be set to the same “Class of Wiring” (CLASS “A” or “B”). If the incorrect 
“Audio Class of Wiring” is selected and the incorrect “Number of Splitters” is entered the following 
message will appear: 

 

 
 

Check all the SP4-APS splitters and ensure that all the CLASS switches are set the same and match the 
“Audio Class of Wiring” setting on the SP4 Telzone Programmer 2 main screen. Check to ensure that the 
number in the “Number of Splitters” box on the SP4 Telzone Programmer 2 main screen matches the 
number of SP4-APS splitters detected by the SP4-TZC. 
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5.7 Troubleshooting Using the Output Screen on the 
SP4 Telzone Programmer 2 Software 

The following Table lists the “Splitter Status” indications listed on the Output Screen. The “Splitter Status” 
command is listed under the “System Info” menu. 

Table 9 
Troubleshooting Using the Output Screen 

 

Name Indication Remarks 

NORMAL Zone Paging can be conducted normally. 

ACTIVE SP40 is in alarm condition broadcasting using the onboard 
microphone, remote microphone or digital voice message. 

Alarm Contact is shorted when NAC/CC switch is in the CC position. 

Alarm Contact IN 

TROUBLE Alarm Contact IN circuit is open. 

NORMAL Zone Paging can be conducted normally. 

ACTIVE SP40 is in alarm condition broadcasting using the onboard 
microphone, remote microphone or digital voice message. 

Alarm Contact is shorted when NAC/CC switch is in the CC position. 

Alarm Contact OUT 

TROUBLE Alarm Contact IN circuit is shorted or open. 

NORMAL Communication from the SP4-TZC to the splitter is being received and 
transmitted. 

RS485 IN Port 

TROUBLE The SP4-APS splitter is not communicating with previous splitters and 
the zone controller. The cause can be open or shorted wiring between 
the RS485 IN and the previous splitter or zone controller. (The 
previous splitter will indicate an “RS485 OUT TROUBLE”.) 

NORMAL Communication from the indicated splitter to the next splitter is being 
received and transmitted. 

RS485 OUT Port 

TROUBLE The SP4-APS splitter is not communicating with subsequent splitters. 
The cause can be open or shorted wiring between the RS485 IN and 
the previous splitter or zone controller. (The next splitter will indicate  
“RS485 IN TROUBLE”.) 

NORMAL Audio Zone is enabled. 

MAJOR SHORT Shorted wiring or Appliance on Audio Zone. Audio Zone disabled. 
See Note 1. 

MINOR SHORT Partial short on wiring or appliance on Audio Zone. Audio enabled.  

Zone 1 - 4 

OPEN Open wiring on Audio Zone or End of Line Resistor missing. Audio 
Zone enabled to the point of the open.  

NORMAL Expansion Zone EX1 or EX2 is enabled. 

MAJOR SHORT Shorted wiring on Audio Booster on Expansion Zone EX1 or EX2. 
Expansion Zone EX1 or EX2 disabled. 

MINOR SHORT Trouble on an Audio Booster connected to the Expansion Zone. 
Expansion Zone is still enabled. 

Expansion EX1 and 
Expansion EX2 

OPEN Open wiring on Expansion Zone EX1 or EX2, or End of Line Resistor 
missing. Expansion Zone enabled to the point of the open.  
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Chapter 6 Warranty 
ANY MATERIAL EXTRAPOLATED FROM THIS DOCUMENT OR FROM COOPER WHEELOCK MANUALS 
OR OTHER DOCUMENTS DESCRIBING THE PRODUCT FOR USE IN PROMOTIONAL OR ADVERTISING 
CLAIMS, OR FOR ANY OTHER USE, INCLUDING DESCRIPTION OF THE PRODUCT'S APPLICATION, 
OPERATION, INSTALLATION AND TESTING IS USED AT THE SOLE RISK OF THE USER AND  COOPER 
WHEELOCK WILL NOT HAVE ANY LIABILITY FOR SUCH USE. 

Limited Warranty 
Cooper Wheelock, Inc. products must be used within their published specifications and must be PROPERLY specified, 
applied, installed, operated, maintained, and operationally tested in accordance with these instructions at the time of 
installation and at least twice a year or more often in accordance with local, state and federal codes, regulations and laws.  
Specification, application, installation, operation, maintenance, and testing must be performed by qualified personnel for 
proper operation in accordance with all of the latest National Fire Protection Association (NFPA), Underwriters' 
Laboratories (UL), Underwriters’ Laboratories of Canada (ULC), National Electrical Code (NEC), Occupational Safety and 
Health Administration (OSHA), local, state, county, province, district, federal and other applicable building and fire 
standards, guidelines, regulations, laws and codes including, but not limited to, all appendices and amendments and the 
requirements of the local authority having jurisdiction (AHJ). Cooper Wheelock, Inc. products when properly specified, 
applied, installed, operated, maintained, and operationally tested as provided above are warranted against mechanical and 
electrical defects for a period of three years from date of manufacture (as determined by date code). Correction of defects by 
Cooper Wheelock, Inc providing repairs or a replacement shall be at Cooper Wheelock, Inc.'s sole discretion and shall 
constitute fulfillment of all warranty obligations.  The foregoing limited warranty shall immediately terminate in the event 
any part not furnished by Cooper Wheelock, Inc. is installed in the product. The foregoing limited warranty specifically 
excludes any software required for the operation of or included in a product. COOPER WHEELOCK, INC. MAKES NO 
REPRESENTATION OR WARRANTY OF ANY OTHER KIND, EXPRESS, IMPLIED OR STATUTORY 
WHETHER AS TO MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR ANY OTHER 
MATTER. 

Users are solely responsible for determining whether a product is suitable for the user's purposes, or whether it will achieve 
the user's intended results. There is no warranty against damage resulting from misapplication, improper specification, 
abuse, accident, or other operating conditions beyond Cooper Wheelock, Inc.'s control. 
 
Some Cooper Wheelock, Inc. products contain software. With respect to those products, Cooper Wheelock, Inc. does not 
warranty that the operation of the software will be uninterrupted or error-free or that the software will meet any other 
standard of performance, or that the functions or performance of the software will meet the user's requirements. Cooper 
Wheelock, Inc. shall not be liable for any delays, breakdowns, interruptions, loss, destruction, alteration, or other problems 
in the use of a product arising out of or caused by the software. 
 
The liability of Cooper Wheelock, Inc. arising out of the supplying of a product, or its use, whether based on warranty, 
negligence, or otherwise, shall not in any case exceed the cost of correcting defects as stated in the limited warranty and 
upon expiration of the warranty period all such liability shall terminate. Cooper Wheelock, Inc. is not liable for labor costs 
incurred in removal, reinstallation, or for damage of any type whatsoever, including but not limited to, loss of profit or 
incidental or consequential damages. The foregoing shall constitute the sole remedy of the purchaser and the exclusive 
liability of Cooper Wheelock, Inc. 
 
In no case will Cooper Wheelock, Inc.'s liability exceed the purchase price paid for a product. 

Limitation of Liability 
Cooper Wheelock, Inc.'s liability on any claim of any kind, including negligence, breach of warranty, or otherwise, for any 
loss or damage resulting from, arising out of, or connected with any contract, or from the manufacture, sale, delivery, resale, 
repair or use of any product shall be limited to the price applicable to the product or part thereof which gives rise to the 
claim.  Cooper Wheelock, Inc.'s liability on any claim of any kind shall cease immediately upon the installation in the 
product of any part not furnished by Cooper Wheelock, Inc. In no event shall Cooper Wheelock, Inc. be liable for any claim 
of any kind unless it is proven that our product was a direct cause of such claim. FURTHER, IN NO EVENT, 
INCLUDING IN THE CASE OF A CLAIM OF NEGLIGENCE, SHALL COOPER WHEELOCK, INC. BE 
LIABLE FOR INCIDENTAL, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES.  Some states do not 
allow the exclusion or limitation of incidental or consequential damages, so the preceding limitation may not apply to all 
purchasers. 
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APPENDIX A 
Telephone Page Zone Control Mapping Guide 

 
 Date:   Page ________ of ________ 

SP4-TZC Location: 

Zone 00 – All Call 
Zones 01 to 68 – Individual Zones 

 Number of SP4-APS Splitters: 

Zones 71 to 77 – Fixed Zones  

Zones 91 to 99 – Logical Zones  
CLASS of Wiring: 

All Splitters must have the  the same CLASS of wiring. 
CLASS A = 2 Zones per Splitter.  CLASS B = 4 Zones per Splitter. 
Background Music is directed to desired areas using the Individual Zones 

 

Zone 
Code Page Location 

BGM 
(Υ) 

Splitter 
Order 
No. 

Splitter 
Serial No.

Location and Type of 
Enclosure (SP40/SPB) 
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Zone 
Code Page Location 

BGM 
(Υ) 

Splitter 
Order 
No. 

Splitter 
Serial No.

Location and Type of 
Enclosure (SP40/SPB) 
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SETTINGS
SW1(NAC/CC) = CC

OUTPUT AUDIO VOLTAGE
JP1 OPEN = 70Vrms
   CLOSED = 25Vrms

CLASS "A" ZONES AND EXPANSION 
TERMINALS REQUIRE JUMPER WIRES 
ON PAIRS NOT USED. OBSERVE POLARITY 
PAIRS ARE: Z1 AND Z2, Z3 AND Z4, 
EX1 AND EX2. 
EOLRs ARE NOT REQUIRED.

CLASS "B" ZONES AND EXPANSION 
TERMINALS REQUIRE UL LISTED 10K OHM 
EOLRs AT THE END OF EACH CIRCUIT 
WHETHER THE CIRCUIT IS USED OR NOT.

CC

OUT IN OUT IN

OUT IN
24 VDC AUDIO

RS-485 ALARM

POWER TROUBLE

Z1 Z2 Z3 Z4 EX1 EX2

INCLASS
B

A

NAC
CC

SW1

SW2

   PAGE
VOLUMEJP

1

STANDBY / RUN

USB
D2

7
D2

5

D1
7

R7

 -AUDIO
    OUT

+AUDIO
    OUTTB3

 RS485
+COM1

 RS485
-COM1

TB5

- POWER

+ POWER TB6

- BGM
  INPUT

+ BGM
  INPUT TB2

TIP    PHONE
              IN

RING TB1

R1
7

BGM VOLUME

       JP1 SETTINGS
1-2 - ALERT PAGE TONE
2-3 - NO ALERT PAGE TONE

RS485 COM1 ACTIVE D2
4

RS485 COM2 ACTIVE

TROUBLE D
29

SPLITTER MISMATCH D
28

RS485 COM LOSS D
26

USB

SP4-TZC

SP40/2

SP4-APS

    24VDC 
Power Supply

 Background 
Music Source

J3

_

_

+_
+

+

TB6

_

_

+_
+

+
TB4

TB3

_

_

+_
+

+
TB2

_

_

+_
+

+
TB5

STB OUT

RET

STB IN

NO
NC

A
L
M

T
R
B

NO
NC

COM

IN3

IN2

IN1

NR

TEL

BGM

AUDIO OUT

CC/NAC

AUX IN

_+ 24
V

NO

COMCOM

POWER

SYSTEM
 RESET

JP1

10K RESISTOR

 Appendix B 
                                                                                   Wiring the SP4-TZC to the SP40/2  

with One SP4-APS Splitter Module 
This drawing is for illustrative purposes only. 
Wire colors are for ease of reading only. 
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W1 = OPEN
NAC/CC=NAC
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Appendix C 

SP4-TZC to SP40/2 with One SP4-APS and  
One Audio Booster with Multiple SP4-APS Splitters  

This drawing is for illustrative purposes only. 
Wire colors are for ease of reading only. 
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SP4-APS SETTINGS
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SW2 (CLASS A/B) = B
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Appendix D 
SP4-TZC with the SP40/2, Multiple SPB-160  

and/or SPB-320 and Multiple SP4-APS Splitters  
Wiring Diagram 

This drawing is for illustration purposes only. 
Wire colors are for ease of reading only. 
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APPENDIX E 
SP4-TZC-P PRODUCT DESCRIPTION AND APPLICATION 

 
 
The SP4-TZC-P model is identical in all aspects to Model # SP4-TZC except for the following: 
 

• Factory default settings are as follows: 
o Zone Paging is disabled; access via standalone telephone or telephone 

system results in an automatic all-call to all zones. 
o Background music is defeated for all zones. 
o Silence detection time-out is 5 seconds. 

 
For a different configuration, e.g., to enable zone paging or to assign background music to any 
or all zones, the SP4-TZC-P may be reconfigured/programmed as outlined in Chapter 3 of this 
manual. 
 
All other aspects, such as application, installation, operation and troubleshooting remain 
identical to the model SP4-TZC. 
 


